Contents

- Brief Overview of ArcMap
- Goals of the Exercise
- Computer and Data Requirements
- Procedure
  1. Displaying and Navigating map
  2. Feature attributes and statistics
  3. Symbolizing features
  4. Classifying features
  5. Making maps for presentation

Brief Overview of ArcMap

ArcMap is an application for displaying and analyzing GIS data. The application window consists of: Map display area, Table of contents (TOC), Menus, tools and buttons. Data Frames are ArcMap document objects where the geographic information of the digital spatial datasets in form of layers is displayed. A Layer is a digital spatial dataset that has been added to a data frame and that has specific properties. Tables are arrays of data organized in rows and columns (i.e. fields) Table can be: Stand alone arrays of data with no
geographic information included or Components of digital spatial datasets in which each row includes feature shape and a unique identification number for each feature called ObjectID.

**Goals of the Exercise**

To introduce you how to

- Display maps, navigate maps.
- Looking at feature attributes
- Creating graphs
- Change default symbology using custom symbology.
- Symbolize features by categorical attributes
- Classifying features by standard methods
- Creating layouts

**Computer and Data Requirements**

This exercise was successfully completed using ArcGIS 8.3. The only component of ArcGIS used was ArcView.

Data and project should be located at C:\GTArcGIS\Chapter03.

**Procedure**

1. Displaying and Navigating maps
(1) Using the Start button on the windows taskbar, open a new ArcMap document.
(2) You see the ArcMap dialog on top of the application window, in this dialog, click on ‘Browse for maps...’
(3) Navigate to C:\GTArcGIS\Chapter03, click on ex03a.mxd and click open.

(4) You can see that the ArcMap document contains three layers: Flight path, Counties and Cities, in which the cities layer is visible as a check mark is not inserted in the square beside its name in the table of contents.
(5) Make the Counties layer disappear by clicking on the check box and turning it off.
(6) Now turn it back on by clicking in the check box again. Also turn on the Cities layer by inserting a check in the box located beside its name. To make the cities visible, now hiding behind other layers, in the table of contents, drag the Cities layer to the top.
(7) Open the Cities layer properties by right clicking on the Cities layer and then on **Properties** for the Layer Properties wizard to appear. Make sure that **General** tab is chosen, if not click on the **General** tab.

(8) You now rewrite the layers name by changing the name from ‘Cities to ‘Cities Viewed’ in **Layer Name** text box and then click apply for the wizard to disappear.
(9) Now you will learn how to use tools toolbar.

(10) On the toolbar, click on the **Zoom In** tool. Then using the new cursor, draw a square on the part of the world of you interest.
(11) You can now adjust the zoomed layer. i.e. move up, down, right or left using the Pan tool. To do this, click on the Pan tool, using the new cursor, click on the map and move the cursor in which ever direction you want.

(12) Now you are going to label the features. You can label the features of any layer with one of the attribute associated with it. For example the cities layer can be labeled with names of the cities. Before going into labeling the Cities layer, you will have to set the properties for labeling.

(13) With the layer zoomed, right click on the Cities layer, and then click on the Properties. In the Layer Properties wizard, click on the Layer tab. You can now select what attribute of the layer should be used for labeling and the properties of the labels. In the wizard, make sure that a check mark is inserted for Label Features in this layer, select Label all the features the same way for Method and select NAME for Label Field. Finally click Apply.
Layer Properties

- Label Features in this layer: checked
- Method: Label all the features the same way
- Test String:
- Label Field: NAME
- Expression...
- Test Symbol:
- Symbol...
- Other Options:
  - Label Placement Options...
  - Scale Range...
  - Pre-defined Label Style
  - Label Styles...

OK Cancel Apply

ArcMap - ArcInfo

Layers window with layers:
- Cities Viewed
- Flight Path
- Countries

Map showing North America with cities labeled.
(14) Sometimes, you would like to see the attributes of a feature on the map. This can be accomplished using Identity tool. To learn how to do this, pick any city you want, next click on **Identity** tool, and finally click on the city you have chosen in the Cities layer.

(15) Now make the map appear in full extent. To do this just click on **Full Extent** tool. Do not close this document yet because you will use it for the next section of the exercise.
2. **Feature attributes and statistics**

(1) You will now learn how to deal with attribute table associated with the layers. In the Table of Contents (TOC), right click on the Cities Viewed layer and then click on **Open Attribute Table**.
(2) Scroll down through the table. There are 28 records, one for each city and scroll across the table to look at the attributes. There are ten attributes (fields). Observe the field OBJECTID, which contains a unique identification number for every record. See the Shape field, which has Point for all the records because all the cities are represented by points. The NAME field contains the names of the cities.

(3) Scroll back all the way to the left so that you can change the width of the NAME field. To do this, take the cursor to the vertical bar that separates NAME and CAPITAL, so that the cursor changes from arrow headed a double headed, the start dragging the vertical bar on to the left until you start to cut off any of the names.

(4) You will now shift NAME field’s position. To do this, scroll the attribute table so that you can see the NAME field. Click on the field name to see that the whole column is highlighted in blue color. Release the click. Then click again on the NAME field, you will see that cursor has changed and then drag the NAME field to left of COUNTRY field. Thus the fields can be rearranged in the table.
(5) As you have already seen, columns can be highlighted, similarly, rows can be highlighted, which is called **Selection**.

(6) You will now select New Orleans city feature by locating it using the NAME attribute from the attribute table. In the table, scroll up or down and try to find New Orleans in the NAME field. Once you have found it, click on the left edge which is shaded on the corresponding row to see that the whole row is selected in blue.
(7) Because you have selected a row in the table which corresponds to a feature, the feature is also selected in the map. Now minimize the table and go to the map.

(8) To look at the selected feature closely, in the map, click on Selection tool, then in the drop down list, click on Zoom To Selected Features.
(9) Now clear the selection by clicking on Selection tool, then in the drop down list, click on Clear Selected Features. Now zoom to full extent by clicking on Full Extent tool.

(10) Rows in a table can be sorted in ascending or descending order based on an attribute. For example you are now going to sort the Cities attribute table according to elevation values. To do open the Cities attribute table again. To do this, right click on the ‘Cities Viewed’ layer and the click on Open Attribute Table.

(11) In the table scroll to the ELEVATION field. Now right click on the field name and then in the drop down click Sort Ascending.
(12) You will see the statistics of the ELEVATION field. Right click on the ELEVATION field name and in drop down click **STATISTICS**. A wizard appears that shows the statistics. Take a look at it. Close the Do not close the ArcMap document.
3. **Symbolizing features**

In the ArcMap document, take a look into the TOC. Observe that below each layer name there is a symbol attached to it. In this section of the exercise you will learn how to change the symbology. Symbology can be changed in different ways. It can be defined by assigning unique symbol to each feature or you can group features of a layer and define a unique symbol for each group. Apart from these there are other ways of symbolizing features.

(1) In the ArcMap document which is open, you can observe that for all the features in Countries layer same symbol has been assigned. You will now change the color from default to yellow color.

(2) To change the default color, in TOC under Countries layer name right click on the symbol, a drop down color palette appears, go ahead and select yellow color. The change in color is soon reflected in the map.
(3) Now that you have changed the color, you will now change the thickness and color of the country boundaries.

(4) To do this, click on the Countries layer symbol which results in the appearance of Symbol Selector wizard.

(5) With the wizard open, in the Options frame, change the Outline Width to 1 and change the Outline Color to brown. Once you have done this click Apply. You can now see the change in the boundaries thickness and color.
(6) You will now change the symbology of the Cities layer.
(7) To do this, click on the Cities Viewed layer symbol which results in the appearance of Symbol Selector wizard.
(8) In the symbol palette, select the Circle 2 type.
(9) With the wizard open, in the Options frame, change the Color to red and change the Size to 10. Once you have done this click Apply.

(10) Now you will change the background color of the data frame to Cretean Blue which is blue right now. To do this, right click on the data frame and then click on Properties.
(11) In the Data Frame properties wizard, click Frame tab, then select Cretean Blue in the Background drop down. Then click on Apply and OK.
(12) With ArcMap open, change the background of the data frame to white again following the procedure explained in the last paragraph.
(13) You now change the symbology based on attribute values. First of all you will make the symbology based on unique values. For example each country can be assigned a different color from others.
(14) To change the symbology based on unique value for Countries layer, right click on it, then click on **Properties**. Then in the wizard that pops up, select **Symbology** tab.
(15) In the left most box which is located under **Show**, click **Categories** and then under options below it click on **Unique values**. You have to now select the name of the field which would have the unique values. To do this select **C NTRY_NAME** in the drop down for **Value field**. Next click on the **Add All Values** button and finally click **Apply** and **OK**. You can now see that each country feature has a different color.
(16) In the TOC, observe that the Symbol legend has a long list of symbols, which had only one value before. To make the legend invisible, click on the minus sign located beside the layer name.

(17) You can try out other options for symbolizing, such as Unique values, many fields and Match to symbols in a style to learn more about symbolizing features.
4. Classifying features

Classifying features consists of assigning the same symbol type to features that are grouped together based on a criterion. Criteria can be based on Natural breaks, which is default method, defining equal intervals which create classes of equal value ranges etc.

(1) You will now classify the country features based on the population values. To change the symbology by combining features into groups, right click Countries layer, and then click on Properties. Then in the wizard that pops up, select Symbology tab.

(2) In the left most box which is located under Show, click Quantities and then under options below it click on Graduate colors. You have to now select the name of the field which would be used for classification. To do this select POP_CNTRY in the drop down for Value in the Fields frame, leave the Normalization as none. Normalization could be used
for example to classify based on Population density instead of population. If you want you can change the number of classes of classification using Classification frame. Finally, click Apply and OK. You can now see that all the features take one of the five colors shown in the legend, based on the population value. If you look at the legend, you will observe a value equal to -9999, because the population of some the countries are unknown. If the Cities Viewed layer is still labeled, remove the labels by right clicking on the layer and then removing the check mark for Label Features in the drop down.

(3) Similarly, there are other options such as charts and multiple attributes type of classification. Try and explore them to learn more about classification of features.
5. **Making maps for presentations**

In this part of the exercise, you are going to create a layout, which is the way to display the information which you infer using GIS. Usually this would be the final step in a project.

(1) Before going into the details of how to create layouts, change the background of the data frame from white color to light blue color as explained previously, i.e. by using the Data Frame properties wizard.

(2) Click the **View** menu and then click **Layout View**.

(3) On the layout toolbar, click the **Zoom Whole Page** button to view the layout properly.

(4) It is important to set up the Page orientation before going into building the layout. Let us use Landscape orientation. To do this, Click **File** menu and then in the drop down click **Page Setup**.

(5) In the **Page Setup** dialog, select **Landscape** for **Page Orientation** which is located on the **Map Size** frame.
(6) Now you can change the displayed map size, by first clicking on it and then dragging the corners.

(7) Next step would be to add a title to this layout. To do this, click on the Insert menu and then Title. A text box appears on the page which contains the ArcMap document name.

(8) To change the title, double click on the text box to see its Properties dialog. In the dialog, enter ‘Countries of the world’ under Text. To change the font and size of the text, click on Change Symbol. In the Symbol Selector wizard, select any font and size you want.
(9) Now you will insert North arrow in the page. To do this click on **Insert** menu, then click on **North Arrow**. **North Arrow Selector** dialog appears, choose what ever type of symbol you want to insert and click **OK**.

![North Arrow Selector](image)

(10) Next insert a scale bar. To do this click on **Insert** menu, then click on **Scale Bar Arrow**. **Scale Bar Selector** dialog appears, choose what ever type of symbol you want to insert and click **OK**.
(11) Next step is to insert legend. To do this click on Insert menu, then click on Legend. In the Legend dialog that appears, remove all the layers except Countries from Legend Items list by selected the removable layers and the clicking the arrow which directs towards the Map Layers list. Click Next.
(12) In the next step of the wizard progress, enter a title for legend and select the font and size if you want. Click **Next**.

(13) In the next step of the wizard progress, select the **Border** and **Background** of your choice. Click **Next**.

(14) Click **Next** again.

(15) Finally to insert the legend, click **Finish**

(16) Give the layout a finishing touch so that it looks as shown in the image below.